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Presenter Notes
Presentation Notes
CHECK THE NOTES SECTION OF THIS POWERPOINT FOR HELPFUL HOW-TO’S FOR COLLECTING DATA ON VARIOUS SECTIONS
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January February March April May June July August September October November December

7457 7511 7585 7653 7685 7743 7792 7898 7974 8058 8132 8217
204 176 177 182 191 185 204 210 214 316 297 295
1774 1825 1526 1577 1614 1640 1636 1826 1828 1898 1858 1861

Number of Users per Month

January February March April May June July August September October November December

9609 9668 9735 9775 9818 9859 9950 10026 10014 10081 10130 10178
241 211 241 216 236 216 213 255 248 243 239 233
1417 1460 1430 1358 1358 1322 1363 1465 1368 1410 1391 1312

2023 Users

2019 Users

Chart Legend

Total Users

Avg. Daily Active Users

Monthly Active Users

2022 Users

January February March April May June July August September October November December

10216 10266 10341 10383 10442 10487 10532 10614 10669
241 242 259 233 259 256 247 282 253
1418 1379 1382 1310 1320 1331 1377 1426 1295

2021 Users

2020 Users
January February March April May June July August September October November December

8272 8327 8374 8410 8454 8485 8568 8659 8704 8755 8800 8884
296 272 282 258 235 253 262 237 238 256 235 263
1844 1909 1713 1573 1596 1638 1676 1671 1595 1639 1467 1640

January February March April May June July August September October November December

8944 9010 9058 9101 9132 9189 9241 9296 9387 9455 9503 9564
255 238 242 239 236 256 244 251 224 231 229 242
1556 1597 1527 1486 1461 1586 1531 1444 1442 1466 1502 1422

Presenter Notes
Presentation Notes
Login to PMP AWARxE > scroll down on the dashboard to the last chart titled Users > update the numbers for each month

We Switched the order of reports and placed the most recent at the top. If you notice the number of Users continues to go up and the number of monthly users are going down. I contribute this to the Gateway or integrated users being required to have an active PDMP account and accessing the information from an integrated platform in their workflow instead of the PMP AWARxE login.



All Reportable Substances Dispensed/Year 
in ND or to ND Residents

0

200,000

400,000

600,000

800,000

1,000,000

1,200,000

1,400,000

1,600,000

2013 2014 2015** 2016 2017* 2018 2019 2020 2021 2022 2023

*Gabapentin reporting started on August 1st, 2017; 2018 was the first full year of gabapentin collection.
**Veterans Affairs facilities started to report data in October 2015

Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore > Appriss Provided [editable] > PDMP Analytics > Dispensations – Over Time > Prescriptions > Change the Year to what year you are updating > Make sure that everything else is set to (All), 
Add up the quarters you’re updating for this quarter and right click on the chart above, choose Edit Data to update the column header and content.





MEDICAL DOCTORS ACTIVE 
ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Pharmacist with Prescriptive Authority and Out of State Pharmacist should go under Pharmacist category, State Medicaid Program, Child Protective Service and Workers Compensation should go under Other (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

MD, DO, DPM, and OD includes dispensing physician, IHS Prescriber, Medical Intern w/Prescriptive Authority, Medical Resident, Military Prescriber, Optometrist, Out of State Prescriber, Physician, Podiatrist, Prescriber w/out DEA, VA Prescriber and Medical Examiner/Coroner

These are the active users by quarter, all of which have increased










PHARMACISTS ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

R.Ph. And PharmD includes: IHS Dispenser, PIC, VA Dispenser

**Added together Pharmacist. PIC, IHS Dispenser, and VA Dispenser



ADVANCED PRACTICE NURSES 
ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Advanced Practice Nurses include: Nurse Practitioner / Clinical Nurse Specialist and Midwife with Prescriptive Authority



PHYSICIAN ASSISTANTS AND 
DENTISTS ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Cause for increase: VA Prescribers Registering for direct access into VA system.




PHARMACY & PRESCRIBER 
DELEGATES ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Pharmacy Delegates include: Pharmacy technicians, Pharmacy technicians-in-training, Delegates for pharmacists (licensed and unlicensed)



LICENSED ADDICTION COUNSELORS 
ACTIVE ACCOUNTS

175
178 179

183
185 185

187
190

193
196

203

208
210 210

150

160

170

180

190

200

210

220

LAC

2019 Q4 2020 Q1 2020 Q2 2020 Q3 2020 Q4 2021 Q1 2021 Q2
2021 Q3 2021 Q4 2022 Q1 2022 Q2 2022 Q3 2022 Q4 2023 Q1

Presenter Notes
Presentation Notes
Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Switched from all accounts to active accounts on Q2 2019



LAW ENFORCEMENT ACTIVE 
ACCOUNTS
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Presenter Notes
Presentation Notes
Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Switched from all accounts to active accounts on Q2 2019

**Total amount in investigator category 



Doctors - Authorization vs. Utilization
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ND DEA Registered Doctors 4574 4910 4948 4963 5076 5112 5157 5198 5300 5395 5483
ND Doctors who authorized prescriptions 3262 3250 3203 3129 3154 3138 3138 3081 3140 3087 3178
ND Doctors also registered with ND PDMP 2150 2008 2294 1960 2304 2357 2370 2372 2387 2418 2459
ND Doctor/their appointed delegate who accessed the

system on their behalf (counts as 1) 2080 1873 1866 1845 1853 1823 1823 1790 1810 1796 1958
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Presenter Notes
Presentation Notes
This data comes from the quarterly reports Appriss Provides, on the ND Prescriber Utilization tab

Can also find using search bar and typing “Prescriber Utilization”

ND DEA Registered Doctors = # DEA Registrants with ND address
ND Doctors who authorized prescriptions = # DEA registrants in ND that authorized prescriptions
ND Doctors also registered with ND PDMP = # DEA registrants in ND also registered with ND PDMP
ND Doctor/their appointed delegate who accessed the system on their behalf = # of ND prescribers or their appointed delegate who accessed the system on their behalf 


The orange bars represent the # of ND doctors registered with DEA, the reddish bars are the number of those ND DEA registrants who also authorized a prescription, pink-brown shows the # who have a PMP account, and tan are the # who looked at a PMP report or had their delegate look on their behalf.



Other Practitioners - Authorization vs. Utilization
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2022
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2023
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ND DEA Registered Other Practitioners 1755 1915 1934 1938 1976 2037 2071 2107 2148 2254 2312
ND Authorized Prescriptions 1749 1499 1513 1494 1527 1558 1558 1564 1609 1643 1703
ND Registered with ND PDMP 1122 1047 1165 1161 1179 1234 1248 1286 1306 1347 1394
ND Practitioner/their Appointed Delegate who Accessed

the System on their behalf (counts as 1) 1116 1046 1060 1054 1077 1125 1125 1140 1165 1182 1216
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Presenter Notes
Presentation Notes
This table and chart show the Other Practitioners registered in ND

DEA Registered = # DEA Registrants with ND address
Authorized prescriptions = # DEA registrants in ND that authorized prescriptions
Registered with ND PDMP = # DEA registrants in ND also registered with ND PDMP
Practitioner/their appointed delegate who accessed the system on their behalf = # of ND prescribers or their appointed delegate who accessed the system on their behalf 

*Values for the category of “Mid-levels” – Madison Nelson




ND Gateway Monthly Requests
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Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > Gateway Details > Gate way Drilldown > Change the Year and Month for a monthly request total….you can collect the next slides totals at the same time for the NDHIE.


Majority of requests are coming from Sanford Health almost 700 K




ND Health Information Network Requests
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Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > Gateway Details > Gateway Drilldown > Select Licensee NDHIE > Go to Request Type and select PatientSearch > Select the month, and the total requests is under the Appriss Health logo

Top Requesting Direct Access Accounts: 




Prescriptions Dispensed by Class
2020
Q1

2020
Q2

2020
Q3

2020
Q4

2021
Q1

2021
Q2

2021 
Q3

2021 
Q4

2022 
Q1

2022 
Q2

2022 
Q3

2022 
Q4

2023 
Q1

Anesthetic 399 377 375 408 356 351 339 300 271 283 356 290 278

Cannabinoid 210 150 160 144 129 171 184 133 139 190 129 153 126

Narcotic/
Opioids

122,044 103,889 114,258 114,039 108,591 113,094 111,760 116,319 111,085 110,425 109,155 115,735 114,039

Other 46,489 44,706 46,866 47,607 45,555 47,138 47,397 47,924 45,938 40,445 46,033 38,230 38,095

Sedative 95,345 89,807 92,203 93,173 89,719 89,719 90,765 90,929 89,194 97,260 90,502 100,119 103,135

Steroid 2,749 2,690 2,700 2,835 2,829 2,969 3,118 3,312 3,279 3,523 2,841 3,635 3,744

Stimulant 58,481 52,224 54,333 57,611 59,052 60,717 62,350 65,936 67,644 70,232 59,331 76,563 80,612

Blank 151 119 213 155 140 147 172 201 208 207 140 68 167

Total 326,679 294,730 311,907 316,777 306,845 314,306 316,085 325,054 317,782 322,565 308,960 334,951 340,268

Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > PDMP Stats > Drugs by Class, County > Adjust timeline in the top right corner to reflect the correct quarter 
Blank is unassigned and Null added together

Last recording of GI narcotic was in March of 2021 (change of its classification?)



TOP 200 PRESCRIBERS BY NUMBER OF 
PRESCRIPTIONS 2022 QUARTER 4
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Presenter Notes
Presentation Notes
Explore > State Created folder > Top Prescribers – Converted > Top Prescribers > Adjust timeline to reflect the current quarter (in lower right hand corner > Hit Download in the upper right hand tab > Data > Download all rows as a text file > NABP interconnect page will pop up, do not sign in, click on excel sheet in the lower left hand corner > Delete all columns except for Measure Names and Measure Values > highlight both columns > Sort Data, sort by A to Z for Measure Names column > Delete data from cells measuring Quantity, want to keep only the cells that count the Prescription Count > Highlight Measure Values column > Sort Data, largest to smallest > Transfer top 200 to the graph in the Powerpoint




Reportable Prescriptions per Patient County 
Quarter 1 - 2023

Patient County 2023 
Population

Prescription 
Count

Prescription 
Count Per 
Population 

Quantity Quantitiy Count 
Per Population Patient Count 

AVG 
Prescription 

Count Per 
Patient

AVG QTY Per 
Patient

Grand Total 773,344 284,235 0.37 15,670,245 20.26 99,962 2.72 156.76 

Adams 2,237 1,024 0.46 61,277 27.39 263 3.89 232.99

Barnes 10,869 5,349 0.49 294,581 27.10 1,582 3.38 186.21

Benson 6,090 2,631 0.43 133,337 21.89 804 3.27 165.84

Billings 839 196 0.23 11,439 13.63 82 2.39 139.50

Bottineau 6,442 2,050 0.32 116,605 18.10 809 2.53 144.13

Bowman 3,024 888 0.29 49,399 16.34 313 2.84 157.82

Burke 2,177 750 0.34 45,568 20.93 243 3.09 187.52

Burleigh 97,895 34,802 0.36 1,919,637 19.61 12,765 2.73 150.38

Cass 182,992 65,899 0.36 3,464,706 18.93 22,513 2.93 153.90

Cavalier 3,725 1,374 0.37 81,072 21.76 496 2.77 163.45

Dickey 5,013 1,962 0.39 115,859 23.11 633 3.10 183.03

Divide 2,196 775 0.35 57,680 26.27 262 2.96 220.15

Dunn 4,054 1,645 0.41 92,744 22.88 574 2.87 161.57

Eddy 2,378 982 0.41 56,613 23.81 308 3.19 183.81

Emmons 3,316 1,022 0.31 53,791 16.22 355 2.88 151.52

Foster 3,396 1,281 0.38 66,127 19.47 468 2.74 141.30

Golden Valley 1,812 651 0.36 34,563 19.07 220 2.96 157.10

Presenter Notes
Presentation Notes
This report comes from Appriss:
Explore > State Created [Editable] > PatientCounty_DrugTrend > Patient County Analysis > select the time frame (months in Q1, 2, 3, or 4) you are looking for (Filled At section) & Uncheck the already selected timeframe > This report will be for all therapeutic classes so leave (All) checked under AHFS Therapeutic Class > Download (at the top), Data, click on download all rows…, open the file, sort by Measure Names, manipulate the data so that the County, Measure Names, and values are all that’s left for data.
Patient County, Prescriptions Count, Quantity 
Copy and paste the prescription count into the prescription count boxes for the next 3 slides, & the same for the Quantity (remove decimals first) and then format it to match the other font using format painter.
Don’t forget to calculate the total & averages on the bottom/3rd slide
FORMAT: Title Row Alignment: Horizontal & Vertical – Center, Font Size 14, Calibri
                 “Prescription per Person”, Format Cells>Number>Decimal places: 3, Alignment>Horizontal Right Indent: 2 & Vertical Center, Highlight cells>Conditional Formatting>Color Scales>Red-Yellow-Green Color Scale, Bold Total/Average Row
                “Units(quantity) per Person”, Format Cells>Number>Decimal places: 2, Alignment>Horizontal Right Indent: 2 & Vertical Center, Highlight cells>Conditional Formatting>Color Scales>Red-Yellow-Green Color Scale, Bold Total/Average Row
(Done in Excel)




*https://www.northdakota-demographics.com/counties_by_population has all the ND counties by population and rank (double check year)
*Take out McPherson county because it’s not actually a ND county (there are 53 counties)
*”Quantity” on the Appriss report is the same thing as Total Dosage Units on the spreadsheet
*Use the SUM and AVERAGE functions on Excel to calculate Prescription Per Person (Prescription Count/Population) and Units Per Person (Total Dosage Units/Population) and also for the Totals row at the bottom of the table
*For the color coating: Highlight row > Conditional Formatting > Color Scales > Top row 2nd one in (the green should be the lowest numbers and gradually going to red for the highest numbers)
* For the Population through Units Per Person right indent formatting: highlight content in excel >  right click > select format cells > choose Alignment tab > under Horizontal: select Right (Indent) > and in the Indent: box select 1 > click OK



Reportable Prescriptions per Patient County 
Quarter 1 - 2023

Patient County 2023 Population Prescription 
Count

Prescription 
Count Per 
Population 

Quantity Quantitiy Count 
Per Population Patient Count 

AVG Prescription 
Count Per 

Patient

AVG QTY Per 
Patient

Grand Forks 73,101 26,821 0.37 1,431,566 19.58 8,738 3.07 163.83

Grant 2,351 811 0.34 50,863 21.63 297 2.73 171.26

Griggs 2,242 824 0.37 44,466 19.83 334 2.47 133.13

Hettinger 2,502 751 0.30 45,121 18.03 303 2.48 148.91

Kidder 2,397 805 0.34 50,644 21.13 318 2.53 159.26

LaMoure 4,173 1,134 0.27 63,742 15.27 509 2.23 125.23

Logan 1,814 609 0.34 40,042 22.07 230 2.65 174.10

McHenry 5,420 2,011 0.37 120,464 22.23 762 2.64 158.09

McIntosh 2,568 965 0.38 52,784 20.55 366 2.64 144.22

McKenzie 13,762 3,526 0.26 191,920 13.95 1,348 2.62 142.37

McLean 9,788 3,855 0.39 236,190 24.13 1,432 2.69 164.94

Mercer 8,405 2,524 0.30 147,598 17.56 1,013 2.49 145.70

Morton 32,916 12,457 0.38 758,993 23.06 4,574 2.72 165.94

Mountrail 9,717 3,910 0.40 220,109 22.65 1,286 3.04 171.16

Nelson 3,035 1,467 0.48 78,916 26.00 451 3.25 174.98

Oliver 1,850 545 0.29 34,440 18.62 208 2.62 165.58

Pembina 6,912 2,999 0.43 175,071 25.33 1,039 2.89 168.50

Pierce 4,038 1,573 0.39 92,462 22.90 555 2.83 166.60



Reportable Prescriptions per Patient County 
Quarter 1 - 2023

Patient County 2023 Population Prescription 
Count

Prescription 
Count Per 
Population 

Quantity Quantitiy Count 
Per Population Patient Count AVG Prescription 

Count Per Patient
AVG QTY Per 

Patient

Ramsey 11,638 5,310 0.46 295,929 25.43 1,606 3.31 184.26

Ransom 5,679 2,672 0.47 132,153 23.27 795 3.36 166.23

Renville 2,328 917 0.39 47,406 20.36 331 2.77 143.22

Richland 16,546 5,936 0.36 335,494 20.28 2,062 2.88 162.70

Rolette 12,508 5,863 0.47 315,318 25.21 2,082 2.82 151.45

Sargent 3,839 1,245 0.32 76,608 19.96 553 2.25 138.53

Sheridan 1,328 521 0.39 31,827 23.97 196 2.66 162.38

Sioux 3,993 1,200 0.30 72,012 18.03 428 2.80 168.25

Slope 775 115 0.15 7,692 9.93 50 2.30 153.84

Stark 32,710 13,258 0.41 737,293 22.54 4,107 3.23 179.52

Steele 1,870 572 0.31 34,533 18.47 245 2.33 140.95

Stutsman 21,678 9,543 0.44 523,535 24.15 3,123 3.06 167.64

Towner 2,190 962 0.44 61,905 28.27 343 2.80 180.48

Traill 8,008 3,024 0.38 182,944 22.85 2,413 1.25 75.82

Walsh 10,631 4,700 0.44 258,467 24.31 1,634 2.88 158.18

Ward 69,686 22,264 0.32 1,219,620 17.50 8,266 2.69 147.55

Wells 4,031 1,843 0.46 103,102 25.58 653 2.82 157.89

Williams 38,460 13,422 0.35 744,019 19.35 4,622 2.90 160.97



Opioid Prescriptions per ND Patient County 
Quarter 1 - 2023

Patient County 2023 Population
Opioid 

Prescription 
Count

Opiod 
Prescription 

Count Per 
Population

Quantity Quantity Count 
Per Population Patient Count

AVG 
Prescription 

Count Per 
Patient

AVG Quantity 
Per Patient

Grand Total 773,344 86,154 0.11 4,052,829 5.24 39,111 2.20 103.62

Adams 2,237 482 0.22 26,489 11.84 157 3.07 168.72

Barnes 10,869 1,618 0.15 74,940 6.89 649 2.49 115.47

Benson 6,090 1,252 0.21 53,766 8.83 419 2.99 128.32

Billings 839 33 0.04 921 1.10 20 1.65 46.05

Bottineau 6,442 647 0.10 29,907 4.64 327 1.98 91.46

Bowman 3,024 284 0.09 16,154 5.34 157 1.81 102.89

Burke 2,177 310 0.14 16,689 7.67 121 2.56 137.93

Burleigh 97,895 11,046 0.11 542,568 5.54 5,080 2.17 106.80

Cass 182,992 15,772 0.09 601,581 3.29 7,569 2.08 79.48

Cavalier 3,725 428 0.11 22,447 6.03 222 1.93 101.11

Dickey 5,013 612 0.12 35,552 7.09 243 2.52 146.30

Divide 2,196 285 0.13 19,533 8.89 116 2.46 168.39

Dunn 4,054 541 0.13 28,530 7.04 235 2.30 121.40

Eddy 2,378 320 0.13 19,667 8.27 127 2.52 154.86

Emmons 3,316 385 0.12 17,516 5.28 167 2.31 104.89

Foster 3,396 477 0.14 24,279 7.15 196 2.43 123.87

Golden Valley 1,812 201 0.11 11,303 6.24 103 1.95 109.74

Presenter Notes
Presentation Notes
Take Population and Population Rank from previous slides
Explore > State Created [Editable] > Kathys_Workbook > MME, Rx Count, & Qty by Patient County > Adjust time line for current quarter in the upper right hand corner > Download > Data > Download all rows as a text file > NABP interconnect page will pop up, do not sign in, click on excel sheet in the lower left hand corner > Highlight all columns and Sort Data by Total MME, smallest to largest > delete the cell data with 0 total MME > Highlight all columns, Sort Data and sort by Patient County A to Z
Copying and paste each county’s cell data into a new sheet (Keep title row if needed) > Highlight Patient Key column, Remove Duplicates (under Data tab), Continue with current section

Prescription Count  SUM of Prescription Count column
Prescription Per Person  Divide Prescription Count by Population
Total Dosage Units  SUM of Quantity column
Unit Per Person  Divide Total Dosage Units by Population
MME Patient Count  Last cell number under Patient Key column (minus 1 for title cell if used), this is why we removed the duplicates previously
Total MME  SUM of Total MME column 
MME Per Patient  Divide Total MME by MME Patient Count





*https://www.northdakota-demographics.com/counties_by_population has all the ND counties by population and rank (double check year)
*”Quantity” on the Appriss report is the same thing as Total Dosage Units on the spreadsheet
*Use the SUM and AVERAGE functions on Excel to calculate Prescription Per Person (Prescription Count/Population) and Units Per Person (Total Dosage Units/Population) and also for the Totals row at the bottom of the table
*For the color coating: Highlight column > Conditional Formatting > Color Scales > Top row 2nd one in (the green should be the lowest numbers and gradually going to red for the highest numbers)
* For the Population through Units Per Person right indent formatting: highlight content in excel >  right click > select format cells > choose Alignment tab > under Horizontal: select Right (Indent) > and in the Indent: box select 1 > click OK



Opioid Prescriptions per ND Patient County 
Quarter 1 - 2023

Patient County 2023 Population
Opioid 

Prescription 
Count

Opiod 
Prescription 

Count Per 
Population

Quantity Quantity Count 
Per Population Patient Count

AVG Prescription 
Count Per 

Patient

AVG Quantity 
Per Patient

Grand Forks 73,101 7,892 0.11 367,586 5.03 3,460 2.28 106.24
Grant 2,351 324 0.14 18,241 7.76 161 2.01 113.30
Griggs 2,242 215 0.10 8,048 3.59 95 2.26 84.72

Hettinger 2,502 304 0.12 17,601 7.03 145 2.10 121.39
Kidder 2,397 290 0.12 16,738 6.98 131 2.21 127.77

LaMoure 4,173 335 0.08 12,405 2.97 186 1.80 66.69
Logan 1,814 180 0.10 9,406 5.19 91 1.98 103.36

McHenry 5,420 685 0.13 32,814 6.05 343 2.00 95.67
McIntosh 2,568 386 0.15 16,815 6.55 149 2.59 112.85
McKenzie 13,762 1,134 0.08 54,672 3.97 588 1.93 92.98
McLean 9,788 1,543 0.16 80,613 8.24 685 2.25 117.68
Mercer 8,405 999 0.12 54,855 6.53 443 2.26 123.83
Morton 32,916 4,358 0.13 240,161 7.30 1,927 2.26 124.63

Mountrail 9,717 1,328 0.14 70,222 7.23 574 2.31 122.34
Nelson 3,035 559 0.18 26,497 8.73 255 2.19 103.91
Oliver 1,850 154 0.08 7,431 4.02 66 2.33 112.59

Pembina 6,912 966 0.14 46,877 6.78 440 2.20 106.54
Pierce 4,038 485 0.12 21,839 5.41 234 2.07 93.33



Opioid Prescriptions per ND Patient County 
Quarter 1 - 2023

Patient County 2023 Population
Opioid 

Prescription 
Count

Opiod 
Prescription 

Count Per 
Population

Quantity Quantity Count 
Per Population Patient Count

AVG 
Prescription 

Count Per 
Patient

AVG Quantity 
Per Patient

Ramsey 11,638 1,950 0.17 95,614 8.22 722 2.70 132.43

Ransom 5,679 738 0.13 28,884 5.09 304 2.43 95.01

Renville 2,328 237 0.10 9,072 3.90 111 2.14 81.73

Richland 16,546 1,653 0.10 65,194 3.94 819 2.02 79.60

Rolette 12,508 2,015 0.16 115,901 9.27 863 2.33 134.30

Sargent 3,839 368 0.10 15,715 4.09 189 1.95 83.15

Sheridan 1,328 198 0.15 10,713 8.07 82 2.41 130.65

Sioux 3,993 557 0.14 28,086 7.03 231 2.41 121.58

Slope 775 30 0.04 2,247 2.90 13 2.31 172.85

Stark 32,710 4,985 0.15 250,908 7.67 2,099 2.37 119.54

Steele 1,870 152 0.08 7,145 3.82 89 1.71 80.28

Stutsman 21,678 2,913 0.13 125,965 5.81 1,280 2.28 98.41

Towner 2,190 322 0.15 21,373 9.76 145 2.22 147.40

Traill 8,008 767 0.10 30,826 3.85 394 1.95 78.24

Walsh 10,631 1,470 0.14 74,819 7.04 675 2.18 110.84

Ward 69,686 5,958 0.09 258,166 3.70 2,903 2.05 88.93

Wells 4,031 635 0.16 30,904 7.67 274 2.32 112.79

Williams 38,460 4,376 0.11 236,634 6.15 2,037 2.15 116.17



PMP InterConnect and PMP Gateway are tools 
being used by PDMPs across the US to combat 
drug diversion and drug abuse nationwide.

PMP InterConnect, the only national network of 
Prescription Drug Monitoring Programs 
(PDMPs), is a secure data-sharing hub that 
breaks down siloes and enables the sharing of 
PDMP data across state lines, providing 
clinicians and pharmacists with a more complete 
patient history upon which to make decisions. 
This capability is critical for physicians and 
pharmacists to more easily identify patients who 
may be obtaining prescription medications for 
any purpose other than the treatment of an 
existing medical condition, including for purposes 
of abuse, misuse or diversion, especially if those 
patients are crossing state lines to obtain drugs. 
PMP InterConnect, as of June 2022, connects 53 
of the 54 PDMPs in the US, facilitating more than 
949 million responses every month. PMP 
InterConnect was developed in 2011 at the 
request and direction of the National Association 
of Boards of Pharmacy (NABP) and a group of 
state PDMP directors. It is governed by its 52 
PDMP members.

Find more information at https://pdmpworks.org

PMP InterConnect



Gateway Facilities

PMP Gateway integrates PDMP data, 
analytics, insights and resources into 
electronic health records, health 
information exchanges, and 
pharmacy management system 
workflows, making it easy and 
efficient for healthcare providers and 
pharmacists to access patient 
information, in line with state 
laws, before prescribing/dispensing 
additional medication. More than 
1.14M prescribers and pharmacists at 
over 158,000 facilities in 43 States 
are using PMP Gateway service in 
110 million patient encounters per 
month.
For ND there were 594 Active 
Gateway facilities in the Last 18 
months. (most recent data June 2022)

Find more facts at https://pdmpworks.org



PDMP Interstate Sharing Hub, PMP Interconnect
- 1.08 billion transactions per month
- Supports 53 of 54 U.S. PDMPs
- The Military Health System elects to participate (2020)
- 247% increase in usage year after year
- PMP InterConnect is provided at NO cost to the PDMPs by NABP
- Interstate data requests over InterConnect are usually returned in 
under two seconds

PDMP Clinical Workflow Integration, Gateway
- 1 in 3 prescribers use PMP Gateway integration
- 179% increase in usage year after year
- Over 107 million transactions are completed each month, March 2022
- Integrations are complete with over 130 electronic health records and 
every major pharmacy system vendor, making implementation quick 
for interested health systems and pharmacies.

This & more data available at pdmpworks.org

Gateway

Presenter Notes
Presentation Notes
No changes to this yet on the website

Visit site on the slide to view the map > open snipping tool (click on the magnifying glass icon in the search bar below and type in “snipping tool”) > Select New > Copy area to snip > File > Save As > Kathy > Bamboo > Reports > Quarterly > Name as “2021 Q3 PMPI map connections”

Map Colors:
EDAD08 Orange=Not Connected
9CCB86 Green=Connected
D9D9D9 Grey=Do Not Utilize PMPi Hubedad08




ND’s PMPi  Hub Connection Status

Military Health

Presenter Notes
Presentation Notes
No changes on the pmpi connections

To Create Map:
https:// mapchart.net/usa.html

Map save under Kathy > Bamboo > Reports > Quarterly > mapchartSave_usa_(1).txt
Word doc is saved as map.docx
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